Inspiration Software Updates

July, 2018

PEP; Ver. 12.05

New Features:

“French Accents” added to the 11 micro fonts.

Fixes:

Minor program fixes.

July, 2018

MQE; Ver. 12.05

Fixes:

Minor program fixes.

July, 2018

MBP; Ver. 12.05

Fixes:

Minor program fixes.
July, 2018

PSV; Ver. 12.05

Fixes:

Minor program fixes.

July, 2018

MQP; Ver. 12.05

Fixes:

Minor program fixes.

July, 2018

WAS; Ver. 12.05

New Features:

“French Accents” added to the 11 micro fonts.

Fixes:

Minor program fixes.
July, 2018
MES; Ver. 12.05

**Fixes:**
Minor program fixes.

July, 2018
MFD; Ver. 12.05

**Fixes:**
Minor program fixes.

July, 2018
VE; Ver. 12.05

**Fixes:**
Minor program fixes.

July, 2018
SSP; Ver. 12.05

**Fixes:**
Minor program fixes.
April, 2018

PEP; Ver. 11.21

1. Update Exquisite Thread 40 weight.

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, Edge, etc.)

3. Windows 10 related bug fixes.

New Features:

1. Align outline points option in Shape tool:
   a. Select an object, click on Shape tool
   b. Select points – either:
      i. Hold down mouse key and drag to select.
      ii. Click on the first point, hold the CTRL key and click on other points to select.
   c. Right click, select Align
   d. Select position
2. Shape tool, when editing an angle line, the length and angle are displayed.

3. Better control for digitizing curved lines and satins. To make a perfect 5 point circle:
   a. Select Tools on the Menu Bar
   b. Select General Options
   c. Select Digitizing
   d. Select Outline input mode: Simple Draw
   e. Place check mark in ‘Curve points as default’ and ‘Circular curves’
April, 2018

MQE; Ver. 11.21

1. Update Exquisite Thread 40 weight.

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, Edge, etc.)

3. Windows 10 related bug fixes.

4. Better control for digitizing curved lines and satins. To make a perfect 5 point circle:
   a. Select Tools on the Menu Bar
   b. Select General Options
   c. Select Digitizing
   d. Select Outline input mode: Simple Draw
   e. Place check mark in ‘Curve points as default’ and ‘Circular curves’
April, 2018

MBP; Ver. 11.21

1. Update Exquisite Thread 40 weight.

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, Edge, etc.)

3. Windows 10 related bug fixes.

**New Features:**

1. Align outline points option in Shape tool:
   a. Select an object, click on Shape tool
   b. Select points – either:
      i. Hold down mouse key and drag to select.
      ii. Click on the first point, hold the CTRL key and click on other points to select.
   c. Right click, select Align
   d. Select position
2. Better control for digitizing curved lines and satins. To make a perfect 5 point circle:
   a. Select Tools on the Menu Bar
   b. Select General Options
   c. Select Digitizing
   d. Select Outline input mode: Simple Draw
   e. Place check mark in 'Curve points as default' and 'Circular curves'

April, 2018

PSV; Ver. 11.21

1. Windows 10 related bug fixes.
Inspiration Software-Updates

April, 2018

MQP; Ver. 11.21

1. Update Exquisite Thread 40 weight.

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, Edge, etc.)

3. Windows 10 related bug fixes.

April, 2018

WAS; Ver. 11.21

1. Update Exquisite Thread 40 weight.

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, Edge, etc.)

3. Windows 10 related bug fixes.

New Features:

1. Better control for digitizing curved lines and satins. To make a perfect 5 point circle:
   a. Select Tools on the Menu Bar
   b. Select General Options
   c. Select Digitizing
   d. Select Outline input mode: Simple Draw
   e. Place check mark in ‘Curve points as default’ and ‘Circular curves’

![Using PEN under ARTWORK](image-url)
April, 2018

MES; Ver. 11.21

1. Update Exquisite Thread 40 weight.

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, Edge, etc.)

3. Windows 10 related bug fixes.

April, 2018

MFD; Ver. 11.21

1. Update Exquisite Thread 40 weight.

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, Edge, etc.)

3. Windows 10 related bug fixes.

New Features:

1. Better control for digitizing curved lines and satins. To make a perfect 5 point circle:
   a. Select Tools on the Menu Bar
   b. Select General Options
   c. Select Digitizing
   d. Select Outline input mode: Simple Draw
   e. Place check mark in ‘Curve points as default’ and ‘Circular curves’
April, 2018

VE; Ver. 11.21

1. Update Exquisite Thread 40 weight.
2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, Edge, etc.)
3. Windows 10 related bug fixes.

New Features:

1. Change to Vintage style in Dime Vintage software.
   a. Select design or a design element
   b. Right click, select Utility
   c. Select Change style.

2. Better control for digitizing curved lines and satins. To make a perfect 5 point circle:
   a. Select Tools on the Menu Bar
   b. Select General Options
   c. Select Digitizing
   d. Select Outline input mode: Simple Draw
   e. Place check mark in ‘Curve points as default’ and ‘Circular curves’
April, 2018

SSP; Ver. 11.21

1. Update Exquisite Thread 40 weight.

2. Links on Today screen automatically open in the Users Default browser (Chrome, Internet Explorer, Edge, etc.)

3. Windows 10 related bug fixes.

**New Features:**

1. Better control for digitizing curved lines and satins. To make a perfect 5 point circle:
   a. Select Tools on the Menu Bar
   b. Select General Options
   c. Select Digitizing
   d. Select Outline input mode: Simple Draw
   e. Place check mark in ‘Curve points as default’ and ‘Circular curves’
January 2018

PEP; Ver. 9.75

**Fix:** Adjusted Toolbar loading delay for latest Win 10 version.

**Features:**

1. You can set the outline distance to Nap Blocker

2. The Nap Blocker option adds a Stop command at the end of the underneath stitches.

3. The default pull-comp setting in Normal style is now Percentage instead of Absolute.
January 2018
MQE; Ver. 9.75
**Fixes:** Adjusted Toolbar loading delay for latest Win 10 version.

January 2018
MBP; Ver. 9.75
**Fixes:** Adjusted Toolbar loading delay for latest Win 10 version.

January 2018
WAS; Ver. 9.75
**Fixes:** Adjusted Toolbar loading delay for latest Win 10 version.

January 2018
MQP; Ver. 9.75
**Fixes:** Adjusted Toolbar loading delay for latest Win 10 version.

January 2018
MES; Ver. 9.75
**Fixes:** Adjusted Toolbar loading delay for latest Win 10 version.

January 2018
VE; Ver. 9.75
**Fixes:** Adjusted Toolbar loading delay for latest Win 10 version.

January 2018
MFD; Ver. 9.75
**Fixes:** Adjusted Toolbar loading delay for latest Win 10 version.

**New:** New artworks have been added to the library.
January 2018

SSN; Ver. 9.75

**Fixes:** Adjusted Toolbar loading delay for latest Win 10 version.

November 2017

PEP; Ver. 9.68

**New Features:**

1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.
2. VP4 format is supported.
3. New emboss settings in PEP:
   - In complex fills and satins, you can change the orientation and the scale.
   - In satins, you can also check the ‘Single’ setting making the emboss pattern follow the direction of the stitches.

4. Navigator tab is available in PEP.
November 2017

MQE; Ver. 9.68

**New Features:**
1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.
2. VP4 format is supported.

November 2017

MBP; Ver. 9.68

**New Features:**
1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.
2. VP4 format is supported.

November 2017

PSV; Ver. 9.68

**New Features:**
1. VP4 format is supported.

November 2017

WAS; Ver. 9.68

**New Features:**
1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.
2. VP4 format is supported.

November 2017

MQP; Ver. 9.68

**New Features:**
1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.
2. VP4 format is supported.
November 2017

**MES; Ver. 9.68**

**New Features:**
1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.
2. VP4 format is supported.

November 2017

**VE; Ver. 9.68**

**New Features:**
1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.
2. VP4 format is supported.

November 2017

**MFD; Ver. 9.68**

**New Features:**
1. VP4 format is supported.

November 2017

**SSN; Ver. 9.68**

**New Features:**
1. Exquisite Thread 40 & 60 weight added to the Thread Palettes.
2. VP4 format is supported.
June 2017

PEP; Ver. 9.55

**New Features:**

1. **Filter:** allows the user to show only selected design portions at the object level.

   **How it works:**
   
   a. Open a design.
   
   b. Left click on Select (F7).
   
   c. Right click in the middle of the design page.
   
   d. Move to “View”.
   
   e. Click on “Filter” (you don’t have to select any design objects first).
   
   f. Select the object or objects you would like to view.
   
   g. Click OK.
   
   h. To return to the full design, right click on the design page, or “All Items” in the Sequence View; move to “View”; select “Show All”
**Note:** When opening a machine format design, .pes, .vp3, .jef, etc. place a check in “Convert to Outlines” in the Open dialog box.

2. **Create Nap Blocker:** used to create a foundation for embroidery when stitching on a nap or pile fabric.

How it works:

a. Open a design.
b. Left click on Select (F7).
c. Select a potion or the entire design.
d. Right click in the middle of the design page.
e. Move to “Utility”
f. Click on “Create Nap Blocker”
3. **Change Style**: allows the user to select one or more design objects and change the way the selected objects sew. Click2Stitch, changes the entire design, **Change Style** changes only the selected object(s). This is a very powerful tool when used with the **Filter** option.

How it works:

a. Open a design on the design page; UnGroup the design.

b. Left click on Select (F7).

c. Select a portion or the entire design.

d. Right click in the middle of the screen.

e. Move to “Utility”

f. Click on “Change Style”

When the **Styles** dialog box appears, select the new style for the selected object(s).

g. For registered users of PEP and Vintage, “Special” design Styles has been added. Quickly convert selected objects to “Vintage” and select the thread weight.

a. Vintage 15

b. Vintage 40
4. **Change Size or Offset**: new convenient way, using scrollbars, to change the size or the offset of an image pattern.

5. **Projection**: Add movement to your designs with this new running stitch feature.

   How it works:
   
   a. The user digitizes a running stitch.
   
   b. The projection perspective is based off the first and last data point in the running stitch object.
   
   c. After digitizing the running stitch, select the running object.
   
   d. In the Run Properties box, change Type: Run to **Projection**.
   
   e. Click Apply.
6. **Color Application:** Change the mouse click behavior on the color palette.

How it works:

a. On the Menu bar, click on Tools/General Options/View.

b. Place a check in “Use left click on palette to apply color”.

c. Click OK.

d. Open design on design page; UnGroup design.

e. Select design object(s).

f. Left click on a color block to apply color change to the selected object(s).

g. Right click to change the Thread Palette

   ![Color Palette](image)

   - Left click, change object color
   - Right click, change Thread Palette

h. **Note:** This is the exact opposite of the program color change default.
June 2017

Vintage Embroidery; Ver. 9.57

New Features:

1. **Change Size or Offset**: new convenient way, using scrollbars, to change the size or the offset of an image pattern.

![Image of software interface showing size and offset settings]

2. **Color Application**: Change the mouse click behavior on the color palette.

How it works:

a. On the Menu bar, click on Tools/General Options/View.

b. Place a check in “Use left click on palette to apply color”.

c. Click OK.

d. Open design on design page; UnGroup design.

e. Select design object(s).

f. Left click on a color block to apply color change to the selected object(s).

g. Right click to change the Thread Palette

![Image of color palette with left and right click options highlighted]

- Left click, change object color
- Right click, change Thread Palette

h. **Note**: This is the exact opposite of the program color change default.
February 2017

PEP; Ver. 9.43

**New Features:**

1. Loading progress bar appears on the program splash screen.

![Loading Progress Bar](image)

2. Dialog box in Carousel, Place, Reflect and Scatter reflects the global unit of measurement.

![Dialog Box](image)

3. Dime threads, Dime 15 wt and 40wt, added to Thread Chart.

4. The selected hoop name is saved in the .c2s file format. When reading back the design, the hoop name appears on the lower right status bar and auto selected in the show hoop dialog.

![Hoop Selection](image)

5. Can read PES Version 9, 10, and Multi positional files.

7. Support for Brother Multi positional hoops (100x172, 130x300 and Jumbo 360x360).

February 2017

MQE; Ver 9.41

New Features:

1. Loading progress bar appears on the program splash screen.

2. Dime threads, Dime 15 wt and 40wt, added to Thread Chart.

3. The selected hoop name is saved in the .c2s file format. When reading back the design, the hoop name appears on the lower right status bar and auto selected in the show hoop dialog.

4. Can read PES Version 9, 10, and Multi positional files.


6. Support for Brother Multi positional hoops (100x172, 130x300 and Jumbo 360x360).
February 2017

MBP; Ver. 9.41

**New Features:**

1. Loading progress bar appears on the program splash screen.

2. Dime threads, Dime 15 wt and 40wt, added to Thread Chart.

3. The selected hoop name is saved in the .c2s file format. When reading back the design, the hoop name appears on the lower right status bar and auto selected in the show hoop dialog.

4. Can read PES Version 9, 10, and Multi positional files.


6. Support for Brother Multi positional hoops (100x172, 130x300 and Jumbo 360x360).
February 2017

WAS; Ver. 9.41

**New Features:**

1. Loading progress bar appears on the program splash screen.

2. Dialog box in Bubble Text reflects the selected global unit of measurement.

3. Dime threads, Dime 15 wt and 40wt, added to Thread Chart.

4. The selected hoop name is saved in the .c2s file format. When reading back the design, the hoop name appears on the lower right status bar and auto selected in the show hoop dialog.

5. Can read PES Version 9, 10, and Multi positional files.


7. Support for Brother Multi positional hoops (100x172, 130x300, Jumbo 360x360). Export/Save is available in PEP through Split design dialog.
Inspiration Software-Updates

February 2017

MQP; Ver. 9.41

New Features:

1. Loading progress bar appears on the program splash screen.

2. Dime threads, Dime 15 wt and 40wt, added to Thread Chart.

3. The selected hoop name is saved in the .c2s file format. When reading back the design, the hoop name appears on the lower right status bar and auto selected in the show hoop dialog.

4. Can read PES Version 9, 10, and Multi positional files.


6. Support for Brother Multi positional hoops (100x172, 130x300 and Jumbo 360x360).
February 2017

SSP; Ver. 9.43

New Features:

1. Loading progress bar appears on the program splash screen.

2. Dime threads, Dime 15 wt and 40wt, added to Thread Chart.

3. The selected hoop name is saved in the .c2s file format. When reading back the design, the hoop name appears on the lower right status bar and auto selected in the show hoop dialog.

4. Support for PNGs with transparency.

5. Multiple frame support in SSP Photo Frames. You can now use templates with multiple frames.

6. New Photo Frames in SSP.

7. Can read PES Version 9, 10, and Multi positional files.


9. Support for Brother Multi positional hoops (100x172, 130x300, Jumbo 360x360). Export/Save is available in PEP through Split design dialog.
February 2017

MFD; Ver. 9.43

**New Features:**

1. Loading progress bar appears on the program splash screen.

2. New Library files added (Ziba Floral).
November 2016

PEP; Ver. 9.25

New Features:

1. The application by default creates outlines after reading a stitch file. This is an option now in File open dialog.

2. Tools - General options - Grid. Change the view order of the grid and guidelines to show them in front of the design.

3. The application shows different marks for curves and corners now; a square for corners, a circle for curves.

4. The auto outline close in complex fill, or when pressing ‘C’ in input mode for runs, etc, depends on the first point type now. If the first point is a curve it creates a curve; previously the close was a straight line.
5. The Spiral feature has been added to Text. Right Click on the word to select.

6. Tools - General options - Digitizing. Option for the default point type in Simple Draw mode; it can be either corner or curve.

7. Tools - General options - View. Option to auto close zoom and pan tools.

8. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

9. Pressing Shift in Shape tool gives priority to outline editing no matter if angle lines or start/stop points are on top. This is useful when editing satin outlines created with the classic satin tool.

10. Short stitches & auto density are available in text paths now.
11. The Name drops feature supports output to a single file. It creates all texts, one on top of the other, in a single file. The texts are centered and separated with Stop commands.

12. The Sequence view supports Groups as separate entities. You can rename the Group by clicking twice on the root (like renaming single paths).

13. Hover the cursor over a small icon displays a preview icon.

14. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe Illustrator).

15. Magic wand tolerance added to Backdrop Properties. To view the Magic wand tolerance adjustment bar, left mouse click on the Backdrop tool icon on the left tool bar, placing a selection box around the backdrop image and activating the Properties- Backdrop box.
16. My Fabric Designs icon added to the add-on bar. Icons are displayed for all registered versions of software listed in illustration.

![Image of add-on bar with icons]

17. ‘3D’ view has been renamed to ‘Realistic’.

![Image of 3D view renamed to Realistic]

18. Guidelines. You can now set custom degrees.

![Image of guideline settings]

19. New ‘Search’ feature has been added to the Library. You can add Keywords to designs in Properties-Design; click Apply.

![Image of search feature in library]

---

34
Right click on the word ‘Designs’ in the Library, select ‘Find’ or press Ctrl+F. You can search for keywords, notes and more.

You can include non-native designs to your search (.jef, .pes, etc.). The initializing is a bit slower the first time and the fields Keywords and Notes are only available for the C2S format.

Tip: Saved ‘Notes and Keywords’ are displayed in the Properties box when the design is dragged and released above the Library box. ‘Notes and Keywords’ are not displayed when the design is dragged directly onto an active design page.

20. Tools – General Options – Environment. New option available to Export Environment (current settings, custom thread charts, etc.); you can Import Environment to a new computer. You can also use it to make a backup copy of your settings and custom objects.

21. Copyright fabric patterns are auto removed before Sending to My Fabric Designs.
November 2016

MQE; Ver. 9.25

New Features:

1. The application by default creates outlines after reading a stitch file. This is an option now in File open dialog.

2. General options - Grid. Change the view order of the grid and guidelines to show them in front of the design.

3. The application shows different marks for curves and corners now; a square for corners, a circle for curves.

4. The auto outline close of the Artwork Pen tool, when pressing ‘C’ in the input mode, depends on the first point type now. If the first point is a curve, it creates a curve; previously the close was a straight line.
5. Tools - General options - Digitizing. Option for the default point type in Simple Draw mode; it can be either corner or curve.

![Digitizing options](image1)


![View options](image2)

7. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

8. The sequence view supports Groups as separated entities. You can rename the Group by clicking twice on the root (like renaming single paths).

![Group in sequence view](image3)

9. Hover the cursor over a small icon displays a preview icon.

![Preview icon](image4)

10. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe Illustrator).

![Bring Forward, Send Backward options](image5)
11. ‘3D’ view has been renamed to ‘Realistic’.


November 2016

MBP; Ver. 9.25

New Features:

1. The application by default creates outlines after reading a stitch file. This is an option now in File open dialog.

2. General options - Grid. Change the view order of the grid and guidelines to show them in front of the design.

3. The application shows different marks for curves and corners now; a square for corners, a circle for curves.
4. The auto outline close of the Artwork Pen tool, when pressing ‘C’ in the input mode, depends on the first point type now. If the first point is a curve, it creates a curve; previously the close was a straight line.

5. Tools - General options - View. Option to auto close zoom and pan tools.

6. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

7. The sequence view supports Groups as separated entities. You can rename the Group by clicking twice on the root (like renaming single paths).

8. Hover the cursor over a small icon displays a preview icon.

9. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe Illustrator).
10. ‘3D’ view has been renamed to ‘Realistic’.


November 2016

MQP; Ver. 9.25

New Features:

1. The application by default creates outlines after reading a stitch file. This is an option now in File open dialog.

2. General options - Grid. Change the view order of the grid and guidelines to show them in front of the design.

3. Tools - General options - View. Option to auto close zoom and pan tools.
4. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

5. The sequence view supports Groups as separated entities. You can rename the Group by clicking twice on the root (like renaming single paths).

6. Hover the cursor over a small icon displays a preview icon.

7. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe Illustrator).

8. ‘3D’ view has been renamed to ‘Realistic’.

November 2016

WAS; Ver. 9.25

New Features:

1. The application by default creates outlines after reading a stitch file. This is an option now in File open dialog.

2. General options - Grid. Change the view order of the grid and guidelines to show them in front of the design.

3. The auto outline close of the Artwork Pen tool, when pressing 'C' in the input mode, depends on the first point type now. If the first point is a curve, it creates a curve; previously the close was a straight line.

4. Tools - General options - View. Option to auto close zoom and pan tools.
5. The Spiral feature has been added to Text. Right Click on the word to select.

6. Tools - General options - Digitizing. Option for the default point type in simple input mode; it can be either corner or curve.

7. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

8. The Name drops feature supports output to a single file. It creates all texts, one on top of the other, in a single file. The texts are centered and separated with Stop commands.

9. The sequence view supports Groups as separated entities. You can rename the Group by clicking twice on the root (like renaming single paths).

10. Hover the cursor over a small icon displays a preview icon.
11. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe Illustrator).

12. Appliqué added to outline choices in Bubble Text.

13. ‘3D’ view has been renamed to ‘Realistic’.


15. Shapes in Bubble text have been updated.
Inspiration Software-Updates

November 2016

SSN; Ver. 9.25

New Features:

1. The application by default creates outlines after reading a stitch file. This is an option now in File open dialog.

   ![File open dialog with Convert to outlines option circled](image)

2. General options - Grid. Change the view order of the grid and guidelines to show them in front of the design.

   ![Grid and guidelines settings](image)

3. The auto outline close of the Artwork Pen tool, when pressing 'C' in the input mode, depends on the first point type now. If the first point is a curve, it creates a curve; previously the close was a straight line.

4. Tools - General options - Digitizing. Option for the default point type in Simple Draw mode; it can be either corner or curve.

   ![Digitizing options](image)
5. Tools - General options - View. Option to auto close zoom and pan tools.

6. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

7. The sequence view supports Groups as separated entities. You can rename the Group by clicking twice on the root (like renaming single paths).

8. Hover the cursor over a small icon displays a preview icon.

9. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe Illustrator).

10. ‘3D’ view has been renamed to ‘Realistic’.

November 2016

MFD; Ver. 9.25

New Features:

1. General options - Grid. Change the view order of the grid and guidelines to show them in front of the design.

![Grid Options](image1)

2. The application shows different marks for curves and corners now; a square for corners, a circle for curves.

![Curve & Corner Marks](image2)

3. The auto outline close of the Artwork Pen tool, when pressing ‘C’ in the input mode, depends on the first point type now. If the first point is a curve, it creates a curve; previously the close was a straight line.

![Artwork Pen Tool](image3)

4. Tools - General options - Digitizing. Option for the default point type in Simple Draw mode; it can be either corner or curve.

![Digitizing Options](image4)
5. Tools - General options - View. Option to auto close zoom & pan tools.

6. Improved snapping to 45 degrees when pressing and holding the Shift key in input mode.

7. The sequence view supports Groups as separated entities. You can rename the Group by clicking twice on the root (like renaming single paths).

8. Hover the cursor over a small icon displays a preview icon.

9. Bring Forward, Send Backward options have been added with handy shortcuts (same as in Adobe Illustrator).

10. Unlimited image size in exporting from Send dialog.

11. Copyright fabric patterns are auto removed before Sending to My Fabric Designs.
May 2016

PEP; Ver. 9.04

Update Notice:

The minimum requirement for our software has been changed to Windows 7, Windows 8, Windows 8.1 and Windows 10 on ALL software.

New Features:

1. New Mettler thread charts and Glide thread chart added.
2. New artwork settings (width, opacity, dash style, stroke for fills):

![Artwork screenshot]

3. New Fabric fill settings:

![Fabric fill screenshot]
4. SVG file improvements – ‘Import as Artwork’ supports fills now. ‘Export as Artwork’ saves Bézier outlines instead of simple polylines.

5. Added reading support for the new Janome JPX format.

6. New Viking Designer Epic hoops; Imperial Hoop 360x260, Crown Hoop 260x200, Splendid Square Hoop 120x120.

7. Import Image as object

8. Ctrl+Click on a palette color pop-ups the standard color dialog box. This is an alternative way for setting a specific RGB color instead of a color from a thread chart.

9. Center origin - works on selected objects now

10. Fit in Hoop can also enlarge the design if needed (the hoop margin setting is as always in Machine settings)
11. 3D effect in complex fill (motif fill type) has been renamed to Dimensional.

![Dimensional option](image)

12. Show/hide Last Stitch indicator in View Menu.

![View Menu with Last Stitch indicator](image)

13. Name drops: Create a text object, add optional decorations and select all. Go to Tools> Name Drops.

![Name Drops dialog](image)

There are several options in this dialog. You can import or export names to a text file and set the alignment. Also you can select the Fit in Width method to make sure long names won't go outside a specific area.
Inspiration Software-Updates

Rectangular and Circular text types are supported in Name Drops. Output example:

14. Guidelines support color and angle now. Using the select tool, right click on a guideline to pop-up the Guideline menu.

15. Vertical text option added:
16. Added support for the QLI quilting format.

17. New Artwork shapes (Star, Round, Heart)

18. Lasso tool, can also be activated in the Stitch tool by pressing the “L” key, the same as the Select Tool.

19. Three new candlewicking motifs

May 2016

MQE; Ver. 9.04

Update Notice:

The minimum requirement for our software has been changed to Windows 7, Windows 8, Windows 8.1 and Windows 10.

New Features:

1. New Mettler thread charts and Glide thread chart added.

2. New artwork settings (width, opacity, dash style, stroke for fills):

3. New Fabric fill settings:

4. SVG file improvements – ‘Import as Artwork’ supports fills now. ‘Export as Artwork’ saves Bézier outlines instead of simple polylines.
5. New Viking Designer Epic hoops; Imperial Hoop 360x260, Crown Hoop 260x200, Splendid Square Hoop 120x120.

6. Added reading support for the new Janome JPX format.

7. Ctrl+Click on a palette color pop-ups the standard color dialog box. This is an alternative way for setting a specific RGB color instead of a color from a thread chart.

8. Center origin - works on selected objects now


10. Guidelines support color and angle now. Using the select tool, right click on a guideline to pop-up the Guideline menu.

11. Added support for the QLI quilting format.
12. New Artwork shapes (Star, Round, Heart)

13. Three new candlewicking motifs

14. Improved stitch drawing quality in View
May 2016

MBP; Ver. 9.04

Update Notice:
The minimum requirement for our software has been changed to Windows 7, Windows 8, Windows 8.1 and Windows 10.

New Features:
1. New Mettler threads charts and Glide thread chart added.
2. New artwork settings (width, opacity, dash style, stroke for fills):

3. New Fabric fill settings:

4. SVG file improvements – ‘Import as Artwork’ supports fills now. ‘Export as Artwork’ saves Bézier outlines instead of simple polylines.
5. New Viking Designer Epic hoops; Imperial Hoop 360x260, Crown Hoop 260x200, Splendid Square Hoop 120x120.

6. Added reading support for the new Janome JPX format.

7. Ctrl+Click on a palette color pop-ups the standard color dialog box. This is an alternative way for setting a specific RGB color instead of a color from a thread chart.

8. Center origin - works on selected objects now.


10. Guidelines support color and angle now. Using the select tool, right click on a guideline to pop-up the Guideline menu.

11. Added support for the QLIquilting format.

12. New Artwork shapes (Star, Round, Heart)

May 2016

MQP; Ver. 9.04

Update Notice:

The minimum requirement for our software has been changed to Windows 7, Windows 8, Windows 8.1 and Windows 10.

New Features:

1. New Mettler thread charts and Glide thread chart added.
2. New Viking Designer Epic hoops; Imperial Hoop 360x260, Crown Hoop 260x200, Splendid Square Hoop 120x120.
3. Added reading support for the new Janome JPX format.
4. Ctrl+Click on a palette color pop-ups the standard color dialog box. This is an alternative way for setting a specific RGB color instead of a color from a thread chart.
5. Show/hide Last Stitch indicator in View Menu.

6. Guidelines support color and angle now. Using the select tool, right click on a guideline to pop-up the Guideline menu.
7. Three new border types. Also the quilt object can support up to 5 borders now.

8. Square block shape:

9. In diamond block shape you can easily set the diamond side now:

10. New tool to set the cell color directly in the design window:
11. Make a design not repeatable using the following button:

12. Improved stitch drawing quality in View.

May 2016

SSN; Ver. 9.04

Update Notice:
The minimum requirement for our software has been changed to Windows 7, Windows 8, Windows 8.1 and Windows 10.

New Features:
1. New Mettler thread charts and Glide thread chart added.
2. New artwork settings (width, opacity, dash style, stroke for fills):

3. New Fabric fill settings:

4. New Viking Designer Epic hoops; Imperial Hoop 360x260, Crown Hoop 260x200, Splendid Square Hoop 120x120.

5. Added reading support for the new Janome JPX format.

6. Ctrl+Click on a palette color pop-ups the standard color dialog box. This is an alternative way for setting a specific RGB color instead of a color from a thread chart.

7. Center origin - works on selected objects now

8. Show/hide Last Stitch indicator in View Menu.
9. Guidelines support color and angle now. Using the select tool, right click on a guideline to pop-up the Guideline menu.

![Guideline menu](image)

10. New Artwork shapes (Star, Round, Heart)

![Artwork shapes menu](image)

11. Improved stitch drawing quality in View
May 2016

WAS; Ver. 9.04

Update Notice:

The minimum requirement for our software has been changed to Windows 7, Windows 8, Windows 8.1 and Windows 10.

New Features:

1. New Mettler thread charts and Glide thread chart added.

2. New artwork settings (width, opacity, dash style, stroke for fills):

3. New Fabric fill settings:

4. SVG file improvements – ‘Import as Artwork’ supports fills now. ‘Export as Artwork’ saves Bézier outlines instead of simple polylines.
5. Added reading support for the new Janome JPX format.

6. New Viking Designer Epic hoops; Imperial Hoop 360x260, Crown Hoop 260x200, Splendid Square Hoop 120x120.

7. Ctrl+Click on a palette color pop-ups the standard color dialog box. This is an alternative way for setting a specific RGB color instead of a color from a thread chart.

8. Center origin - works on selected objects now

9. Show / hide last stitch indicator in View menu

10. You can now use tilde symbol to keep words together in WAS. Example: New~York City

11. Name drops: Create a text object, add optional decorations and select all. Go to Tools> Name Drops.

There are several options in this dialog. You can import or export names to a text file and set the alignment. Also you can select the Fit in Width method to make sure long names won’t go outside a specific area.

Rectangular and Circular text types are supported in Name Drops. Output example:
12. Guidelines support color and angle now. Using the select tool, right click on a guideline to pop-up the Guideline menu.

13. Vertical text option added:

14. New Artwork shapes (Star, Round, Heart)

15. Improved stitch drawing quality in View.
January 2016

PEP; Ver. 8.66:

Add-ons bar in PEP: Icons have been added to the right side of the PEP screen for registered owners of MQE, MBP, MQP and/or WAS; simply click on your Inspiration Software program icon to access the program and create your project all on one screen without opening several programs. For additional program options, simply click on the arrow under the program icon.

Artboards: Artboards have been added to the Save as option. You can add artboards to a design to define multiple hoop areas or to export smaller portions from the main design. Place a √ check mark in Artboard in the Artwork Properties box before drawing the artwork shape, or select the artwork shape, select Artboard, click Apply.

You can change the artboard labels in the Sequence View to rename the portion selected. In File/Save as, select “Use Artboards” to export multiple designs.

Notes: text alignment in Notes text box has been added.

PEP, MQE, WAS; Ver. 8.66: Color change between words has been added to the Circle Text option on the Commands tab in the Properties Box.
All Inspiration Software Programs, version 8.66

The Software registration/activation process has been streamlined. Each serial number may be activated one time via the web for each software program. To receive a second activation, contact the Support Desk (on top menu bar: Help/Software Support in each software package). After this request, the system will automatically allow you to unregister from one of your computers and then register/activate a new computer for the registered software owner without contacting the Support Desk.

Only the registered owner may use 2 computers with activated software as per the license agreement. If the registered owner wishes a second activation for a second computer, in accordance with the license agreement, the registered owner must contact the Support Desk as described above.

Snap to Grid, it is now easier to create quilt blocks and edit designs with this new update. If you are close to the horizontal or vertical grid or guidelines, the point, object or design selection automatically snaps to the nearest grid or guideline.

Design Library: When dragging a design from the design library to the design page, the design is merged on the active page. When the design is moved outside the active area of the design page, it is opened on a new design page. Illustration: the design is moved into the Properties box; the mouse button released and the design is opened on a new design page.

Brother hoop 240 x 360mm has been added to all Inspiration Software Programs

HQV format has been added to Inspiration Software Programs that support, read and write quilting formats.

My Quilt Planner, Ver. 8.66: Block marks icon has been added to the top tool bar. Remove Quilt option is located under the arrow on the Quilt Icon.

Word Art in Stitches; Bubble Text Ver. 8.66: All letters are generated when fonts with capital letters only are selected and typed as upper and lower case.

My Quilt Embellisher Ver. 8.66: DFX has been added to Open and Save options.
August 31, 2015

Word Art in Stitches, Ver. 8.54

New Shape and Décor Designs!

14 Shape designs

269 Décor designs
July 2015

Perfect Embroidery Pro, Ver. 8.47

1. Auto match threads when loading .c2s designs; default thread brand is displayed in the Sequence View.

2. The ‘Today’ page shows up large enough in Microsoft Surface.

3. The warning when saving PES designs larger than 200 x 300 (or 300 x 200mm)

4. Added support for putting ‘Color changes” instead of “Stops” in appliqué. ‘Stops’ work fine for the majority of the machines by creating 3 identical colors; however some machines (like some Bernina models) ignore the color changes. With the new ‘Change color” setting in Appliqué Properties these machines are forced to stop between colors. In the illustration, the tack down line color is changed.

5. Added ‘Break up’ support for Buttonholes. The result is 2 grouped outline objects; one for the button hole and a second for the decoration. Each element may be edited separately.
My Block Piecer, Ver. 8.48

1. Added support for holes in Cutter tool.

2. Added support for Brother FCM Import (File>Import Artwork)
Perfect Stitch Viewer, Ver. 8.40:

**Fixes:** Resolved the icon view with PSV and PEP. Click on the Perfect Stitch Viewer icon on your desktop, click on Check for Updates.

![Perfect Stitch Viewer icon](image)

Perfect Embroidery Pro, Ver. 8.40:

Brother machine occasionally failed to read PES files created from designs with Stop Commands; this has been fixed.

**New:**

1. Juki .m3 format has been added
2. Two line circular text feature added: Type text on two lines, select the Circle option, Click Apply.

![Two line circular text feature](image)

**Improvements:**

Text Design fonts: Scr43133 – Scr43158 have been updated. When updating PEP, download and install the Support Files as well or go to [http://HereToHelp.InspirationSupport.com](http://HereToHelp.InspirationSupport.com) and submit a ticket requesting the support files.

My Quilt Embellisher and My Block Piecer Ver. 8.33

**Fixes:** minor fixes to software
February 2015 Program Updates:

Perfect Embroidery Pro. Ver. 8.33:

Fixes:
1. Control Key / duplication. *(Select the element; left click on the Duplicate icon. Hold down the keyboard Ctrl key, left click on the design page to generate an exact duplicate of the element)*
2. Show/Hide eye icon in Sequence View is now working properly.

New:
1. New button holes with decorations
2. Touch options (touch screen)

Improvements (stitch generations)
1. Better maze type stippling. It creates a single run with no trims and no border cropping; it doesn’t create trims even with fills with holes. You can still select the ‘Hilbert’ and ‘Piano’ stippling types to get the old style border.

![Maze](image1)
![Maze with Hole](image2)
![Hilbert](image3)
![Piano](image4)

2. Better motif fills; motif fills with HOLES, it, in general, creates less trims than before.

![Motif](image5)
![Motif with Hole](image6)
My Block Piecer Ver. 8.30

**Fixes:**

1. Control Key / duplication. *(Select the element; left click on the Duplicate icon. Hold down the keyboard Ctrl key, left click on the design page to generate an exact duplicate of the element)*

2. Show/Hide eye icon in Sequence View is now working properly.

**Improvements:**

1. Improved Work Flow engine

**New:**

1. More blocks added.

My Quilt Embellisher Ver. 8.30

**Fixes:**

1. Control Key / duplication. *(Select the element; left click on the Duplicate icon. Hold down the keyboard Ctrl key, left click on the design page to generate an exact duplicate of the element)*

2. Show/Hide eye icon in Sequence View is now working properly.

**Improvements (stitch generation):**

1. Better maze type stippling. It creates a single run with no trims and no border cropping. It doesn’t create trims even with fills with holes.

![Maze](image1.png)

![Maze with Hole](image2.png)

2. Better motif fills; motif fills with HOLES, it, in general, creates less trims than before.

![Motif](image3.png)

![Motif with Hole](image4.png)
Perfect Embroidery Pro 8.27

**Fixes:**
1. Beads Browse Catalog - the title says ‘Bead’ now instead of ‘Button Hole’
2. Keep aspect ratio’ in Scatter is fixed now.

**Improvements:**
1. Smoother icons
2. Monogram, Motif and Applique designs buttons are menu items now (under Text designs)
3. Lasso button is a menu item now (under select tool)

**New features:**
1. Buttonholes

Perfect Embroidery Pro 8.23

**Fixes:**
1. Janome thread chart has been updated with new thread codes
2. Added support for Microsoft Surface tablet
3. ‘Auto resequence by color’ in Scatter, Shape & Reflection template is working now
4. C2S file associations work as expected now.
   Note: The new PEP fixes the problem the first time it runs. Then double clicking on .c2s files should be working fine.
5. Converting Complex fills, etc. to Artworks is working now

**Improvements:**
1. Improved 3D view
2. The setup doesn’t reset the program’s settings

**New features:**
1. Beads
Perfect Stitch Viewer 8.21

**Fixes:**

1. PSV icons appear in PEP and other programs now. You need to install the PSV v8.21.

**Improvements:**

1. Registration dialog in PSV

**Inspirations Software 8.15 version**

Here are the updates that we have worked on/added for this month in the Tools area:

1. Reflection template added
2. Shape template added
3. Scatter template added
4. New advanced options in Repeat design take a look!

We have added new designs in Free design of the Month!
October Updates

Wow! October’s free updates in Perfect Embroidery Pro are amazing.

3D motif

The 3D motif feature transforms simple shapes with a click of the mouse. When applied, the motif filled areas appear to pop off the screen or fabric. The motifs are largest in the center and gradually get smaller towards the edges of a design.

When would you apply the 3D feature? My first thoughts include Christmas ornaments, balls, spheres, Easter eggs, sun, moon, buildings in landscapes, and flower centers. The feature is not limited to ovals, circles and rectangles. In fact, anything that can be converted to a complex fill can be morphed with the 3D feature.

Variable size motifs in run path

Not only applicable to filled shapes, variable size can also be applied to a run path. Perfect for neckline adornments, fireworks or burst designs.
Inspiration Software – Perfect Embroidery Pro v8.14

Search in catalogs

All catalogs (blocks, fabrics, applique shapes, text designs, etc) are now searchable. Click on the catalog (accessed by its corresponding icon) and enter the search term. Click on the up/down arrows to jump to the first match.

Placement marks for hoops

Placement marks or stitch marks can now be added to any location in a design. Helpful for creating continuous embroidery designs, placement marks identify the point of connection between two designs and are removable after the embroidery process is complete.
Inspiration Software – Perfect Embroidery Pro v8.14

PNG image

PNG images are a more versatile image format than standard jpg files. When saving a design as a PNG image, you can change the resolution of the design and select a transparent background. These features produce a more sophisticated image when communicating with customers, students or other embroiderers.

Enhanced Zoom Feature

In addition to the traditional methods of enlarging the image on the screen (magnifying glass icon and the percentage box), now there’s a time saving keyboard shortcut. Position the cursor on a specific point, hold down the CTRL key and roll the wheel on the mouse to zoom.

Add a Note to an embroidery file

When selected, the notepad icon lets you type a message in the sewing field of the design. Just type the message and it appears on the screen. You can relocate the message to any area within the design, resize the note and change the font.
Perfect Embroidery Pro Version 7.52

New features now available in the Perfect Embroidery Pro 7.52 update:
For complete details and illustrations, click on the Online Manual button on the My Inspiration Today Page; this page is available when connected to the Internet. On the Pure Inspiration page, click on the plus sign (+) in front of Perfect Embroidery Pro; select New Inspiration in Perfect Embroidery.

Inspiration Design Library: Includes 300 designs provided by Great Notions.

Design Conversion & Artwork Tools: convert designs and export artwork in five formats, .SVG for Silhouette™; .AI, .PLT, .DXF and .FCM for Brother Scan & Cut™. Export Artwork is a “save as” function and only the artwork is saved; click on File>Export Artwork.
**Mini Fonts for Small Lettering:** The mini font collection consists of 10 new fonts ranging from 3 to 6 mm. The mini fonts are designated by the lower case m preceding the font name in the Font Library.

**Click2Stitch Stabilizer and Hooping Companion:** With the design on the design page, select File>Click2Stitch from the drop down menu. Answer a few simple questions about the design and fabric; the design is modified to fit the fabric type and specific hooping and stabilizing recommendations are also provided.

**One Click Thread Brand Conversion:** Click on the Change Palette icon, located on the right side of the color and thread selection tool bar under the design page.

1. Click on the down arrow to display the thread brand dialog box.
2. Click on the new brand.
3. Click OK to accept the changes and close the dialog box.
**Center Origin Features:** Moves the design to the center of the design page with full design view. Right click on the ruler bar, located across the top of the design page or down the left side, select Center Origin. The design is centered and fully displayed on the design page.

**Placement Mark Feature:** Placement marks are used to align or match up subsequent hoops or anytime when perfect placement is required. Click on the Placement Marks icon; select any or all of the eight different alignment marks. The placement marks are listed in first position in the Sequence View.
**Split Designs:**

When a design is too large for the selected hoop size, Professional Embroidery Pro has two solutions.

1. Click on the down arrow under the Hoop icon, select Auto Fit. This tool transforms the size of the design to fit the selected hoop size.

2. If the design is smaller than desired, select the Split Design tool. This tool divides a design into stitchable segments for the designated hoop.
My Quilt Embellisher Version 7.52

New features now available in the My Quilt Embellisher 7.52 update:
For complete details and illustrations, click on the Online Manual button on the My Inspiration Today Page; this page is available when connected to the Internet. On the Pure Inspiration page, click on the plus sign (+) in front of My Quilt Embellisher; select New Inspiration in My Quilt Embellisher.

Unleash the Inner Quilt Designer Within YOU!

Audition your fabrics, blocks and appliqués with DIME’s new Inspired Fabric Library, shared with My Quilt Embellisher, My Block Piecer and Perfect Embroidery Pro. To open the Fabric Library, click on the Fabric icon on the tool bar.
New features now available in the My Block Piecer 7.52 update: For complete details and illustrations, click on the Online Manual button on the My Inspiration Today Page; this page is available when connected to the Internet. On the Pure Inspiration page, click on the plus sign (+) in front of My Block Piecer; select New Inspiration in My Block Piecer.

Unleash the Inner Quilt Designer Within YOU!

Audition your fabrics, blocks and appliqué with DIME’s new Inspired Fabric Library, shared with My Block Piecer, My Quilt Embellisher and Perfect Embroidery Pro. To open the Fabric Library, click on the Fabric icon on the tool bar.